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Purpose This document describes the process of installing the Signum Chameleon 

WEMU51 debugger for use with the Signum Systems USP-51 emulator for the 
8051 family of microcontrollers.  

Installation 
1. Insert the Development Tools for Microsoft Windows CD into your CD-ROM 

drive. In the Master Setup dialog box, select Chameleon Debugger and 
double-click USP-51 ICE, as shown in Figure 1. 

 
FIGURE 1  Chameleon Master Setup dialog box. 
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2. On Windows XP/2000/NT, the dialog box shown in Figure 2 appears. 
If you intend to use the parallel with your emulator, click the Yes button. 

 
FIGURE 2   Installing the parallel driver. 

3. Complete the Chameleon WEMU51 debugger installation process. 

4. Connect the USP-51 emulator to your computer through either a serial 
port (e.g., COM1) or parallel port (e.g., LPT1), then connect it to the 
power supply. Plug the power supply cord into an outlet. Attach the 
POD to the emulator using the two white flexible cables that extend 
from the emulator’s front panel. Turn the emulator on. Do not connect 
the POD to the user target yet—please complete the installation 
procedures described below first. 

5. Start WEMU51 by selecting the Windows Start menu and clicking 
Programs | Signum Systems WEMU-51. If you installed Chameleon 
WEMU51 for the first time, the WEMU51 Project Manager dialog box 
appears (Figure 3). 
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FIGURE 3   WEMU51 Project Manager dialog box.. 

Create a new debug project to start working with your emulator. The fastest 
way to do so is to click the Create New button in the dialog box in Figure 3. 
This launches the Project Creation Wizard. 

Clicking the Cancel button dismisses the Project Manager dialog box  and 
enables the debugger menus. Note that some of Help and Project 
submenus are available regardless of your project status. This allows you to 
read the program documentation (Help | Contents), obtain the program 
version number (Help | About) or create a new project (Project | Create 
New). 

If you reinstalled the debugger, but earlier had created a project with a 
previous Chameleon WEMU51 version, then click the Open button. This 
brings up the standard Windows Open dialog box. Browse for the project 
configuration file Wemu51.CNF located in the project directoryan select it. 
This opens the corresponding project.  
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You can create a brand new project using the Project Creation Wizard 
accessible from the WEMU51 Project Manager dialog box. Press the 
Create New button or select Create New from the File menu (Figure 4). 

 
FIGURE 4   Project Creation Wizard—opening dialog box. 
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Click Next to begin creating a new project. Enter the project name along 
with optional comments (Figure 5). 

 
FIGURE 5   Naming the project. 



S I G N U M  S Y S T E M S  
 

6 

Click Next. The wizard prompts you to select the project folder (Figure 6). 
The folder will contain your application executable file, source code files, the 
project command startup file Wemu51.INI, definitions of custom toolbar 
buttons and other project specific files. 

 
FIGURE 6   Selecting the project library. 



C H A M E L E O N  W E M U 5 1  F O R  T H E  U S P - 5 1  
I N S T A L L A T I O N  I N S T R U C T I O N S  

7 

Click Next. Select USP-51 In-Circuit Emulator as the target for your project, 
as shown in Figure 7. 

 
FIGURE 7   Selecting the emulator. 
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Click Next. In the dialog box that appears, choose the communication 
device, such as one of the host computer communication ports, to connect 
the selected target device (the USP-51) with the host. From he Detected 
Devices list, select the same port you chose in step 4 above. However, if you 
connected the emulator to the network, you should select IceServer. Set the 
remaining parameters. For best performance with the serial port or IceServer, 
set the highest baud rate, 57600 bps. When using the parallel port under 
Windows ME, 98 or 95, it is necessary to select the base LPT port address. 
This address can be found in the Device Manager available from the 
Windows Control Panel. Windows XP, 2000 and NT provide the base LPT 
port address automatically; its value cannot be modified and is grayed out 
(Figure 8). 

 
FIGURE 8   

Click Next. In this step, you select the processor for your project. From the 
list of available devices, select the processor whose name corresponds to the 
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processor chip located on the POD connected to the USP-51 emulator via 
two wide flexible cables (Figure 9). 

 
FIGURE 9   Selecting the emulator. 

Clicking on the Next button brings up the last wizard dialog box. It 
summarizes the choices you have made. If you want to modify some of these 
settings, press Back to go to the appriopriate wizard dialog box. Make the 
desired changes and return to the last dialog box. Verify that the Open new 
project after it is created check box is checked. Finally, press the Finish 
button to create the new project. 

6. Chameleon WEMU51 debugger opens the project you have created and 
establishes communication with the USP-51 emulator as the target. The 
Select Clock and Power Settings dialog box appears. Please select the 
processor power source as external (i.e., from your target board) if the 
emulator’s POD is plugged into your target board. If the POD is in the 
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standalone mode, that is, not connected to any target board, the source 
should be internal (i.e., from the emulator). 

Select the processor clock source as external 
or internal (from the POD) if the emulator’s 
POD is plugged into your target board. When 
the POD is unplugged from your target board, 
then select internal. Choose the appropriate 
clock frequency and clock speed rate: x2 for 
new chips from Atmel W&uC, Philips or 
another brand if you plan to use the x2 speed. 
Otherwise, select x1. The effective processor 
frequency is calculated as the selected 
frequency times the speed rate. 

 
FIGURE 10   Power and clock selection. 

7. Upon opening the project, the debugger main window contains the 
Status, Source, Symbol Explorer and Command windows. Note the 
names of the selected target (Emulator) and project (Test Project) displayed 
on the debugger’s title bar (Figure 11). 

Note: The clock 
frequency selected in 
the dialog box does 
not set the 
frequency of the 
processor clock 
located on the POD 
or on your target 
board. This value is 
simply used by the 
debugger when 
timing data have to 
be calculated. 
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FIGURE 11  Typical project initial screen. 

The File menu can be used to select and load your application and to open 
or save various data from/into files. 

The View menu provides access to various debugger windows, such as 
Status or Command. 

The Debug menu allows you to start, stop and step through a loaded 
application and trigger breakpoints. 
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The Project menu facilitates project management tasks. Use it to create 
new projects, list and open existing ones, close the current project and 
modify its settings. 

The Options serves the purpose of modifying the project target and 
communication device as well as customizing the toolbars. 

The Help menu allows you to open the debugger documentation (Help 
| Contents), display the debugger version information (Help | About), 
open Signum web pages (to check for the latest software upgrades, for 
instance, or send a message to the Signum Systems support personnel. 

Turn the entire system off 
and connect the POD to the 
target board. 

 

In the Command window on the right side of your screen, you should 
see a record of the WEMU51.ini file commands that were executed 
when the project was opened. This project startup command file contains 
the commands run automatically by the debugger when the project 
opens. Note that the memory mapping is such that the memory on the 
target board is used and the POD is ready for target board development 
and debugging. However, if you choose to work with the program before 
it connects to the target board, you need to remap the memory so that 
the emulator's memory is used instead. To accomplish that, type “map 
P all I” (map the entire program memory to the emulator) in the 
Command window and hit the Enter key. Then type “map X all 
I”. This places the external memory data in the emulator’s memory 
(Figure 12). 

Note: If you would like to explore the 
program before connecting to the target 
board, proceed as outlined below. 
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FIGURE 12  Remapping the memory. 
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Technical Support 

C O N T A C T  I N F O  

 1211  Flynn Road , Unit 104 

 Camarillo , California 93012 

℡ (805) 583-3682 

 (805) 583-3685 

 www.signum.com 

 signum.com/support.htm 

 signum.com/sales.htm 

Contact Signum Systems Technical Support by 
dialing (805) 523-9774, Monday through Friday 
between 9 A.M. and 5 P.M. Pacific Time. In order 
to enable our technical support engineers to
process your request efficiently, we strongly
recommend submitting the Technical Support
Request form available at 
signum.com/support.htm. 

A Friendly Reminder We will be able to serve you 
better if, when contacting our Tech Support,
you are at your computer, have your
documentation at hand and are prepared to 

provide: 

1. The version of your Signum Systems software, hardware or firmware that 
you are using and the serial number of your emulator. 

2. The exact wording of any messages and prompts that appear on your screen. 

3. The environment, in which your software is running, including the type of
hardware and operating system. 

4. A description of what happened and what you were doing when the
problem occurred. 

For more information, please visit our home page on the World Wide Web.   
 

SWII-ChamUSP-51 11.5.04.16.50 480 
 


	Installation
	Technical Support



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts false
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /ACaslonPro-Bold
    /ACaslonPro-BoldItalic
    /ACaslonPro-Italic
    /ACaslonPro-Regular
    /ACaslonPro-Semibold
    /ACaslonPro-SemiboldItalic
    /AGaramondPro-Bold
    /AGaramondPro-BoldItalic
    /AGaramondPro-Italic
    /AGaramondPro-Regular
    /AGaramondPro-Semibold
    /AGaramondPro-SemiboldItalic
    /AJensonPro-Bold
    /AJensonPro-BoldCapt
    /AJensonPro-BoldDisp
    /AJensonPro-BoldIt
    /AJensonPro-BoldItCapt
    /AJensonPro-BoldItDisp
    /AJensonPro-BoldItSubh
    /AJensonPro-BoldSubh
    /AJensonPro-Capt
    /AJensonPro-Disp
    /AJensonPro-It
    /AJensonPro-ItCapt
    /AJensonPro-ItDisp
    /AJensonPro-ItSubh
    /AJensonPro-Lt
    /AJensonPro-LtCapt
    /AJensonPro-LtDisp
    /AJensonPro-LtIt
    /AJensonPro-LtItCapt
    /AJensonPro-LtItDisp
    /AJensonPro-LtItSubh
    /AJensonPro-LtSubh
    /AJensonPro-Regular
    /AJensonPro-Semibold
    /AJensonPro-SemiboldCapt
    /AJensonPro-SemiboldDisp
    /AJensonPro-SemiboldIt
    /AJensonPro-SemiboldItCapt
    /AJensonPro-SemiboldItDisp
    /AJensonPro-SemiboldItSubh
    /AJensonPro-SemiboldSubh
    /AJensonPro-Subh
    /Parchment-Regular
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages false
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages false
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages false
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages false
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages true
  /DownsampleMonoImages false
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth 8
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


